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Présentation 
 
Ce guide de l’utilisateur contient des informations importantes sur l’utilisation 
de l’outil de pipeline d’analyse de données Agendia (Agendia Data Analysis 
Pipeline Tool, ADAPT-CE), qui est une plateforme cloud d’analyse génomique 
hautes performances et conforme aux normes de sécurité. ADAPT-CE est 
destiné à être utilisé avec le kit de récidive du cancer du sein et de sous-typage 
moléculaire MammaPrint® BluePrint® (kit MammaPrint BluePrint). ADAPT-CE 
fournit des analyses intégrées et des rapports de résultats des échantillons 
traités avec le kit MammaPrint BluePrint NGS. 
 
Ce guide de l’utilisateur fournit des instructions détaillées pour créer un 
compte, installer un connecteur de fichiers sécurisé, téléverser et analyser les 
données anonymisées des patients dans un environnement sécurisé, et 
récupérer les résultats des tests. 
 
Avant de commencer, consultez toutes les instructions de ce guide de 
l’utilisateur.  
Si vous avez encore des questions après avoir lu ce guide de l’utilisateur, veuillez 
contacter NGS.support@agendia.com pour obtenir de l’aide. 
 

Exigences du système 
EXIGENCES D’ADAPT-CE 
ADAPT-CE est un système cloud sécurisé accessible via les navigateurs pris en 
charge répertoriés ci-dessous. 
 

Navigateur Version prise en charge Système d’exploitation 
Google Chrome Dernière version stable  Windows, Mac et Linux  
Mozilla Firefox Dernière version stable  Windows, Mac et Linux 
 

Pour le bon fonctionnement d’ADAPT-CE, assurez-vous que les cookies sont 
activés dans le navigateur. 

EXIGENCES RELATIVES AU CONNECTEUR DE 
SERVICE AGENDIA  
Le connecteur de service Agendia est un connecteur de transfert de fichiers 
sécurisé qui doit être installé pour téléverser des données dans ADAPT-CE. 

Le connecteur de service Agendia peut être installé dans les environnements 
Windows, Mac et Linux. 
 
Pour un bon fonctionnement du connecteur : 

• Assurez-vous que la bande-passante de votre connexion Internet est de 
1,5 Mbit/s ou plus. 

• Assurez-vous que les ports sortants TCP443 (SSL) et TCP22 (SSH) sont 
ouverts dans les pare-feux éventuellement présents. 

 
 ATTENTION : Les utilisateurs peuvent avoir besoin de privilèges 

administrateur sur leur ordinateur pour installer le connecteur de service 
Agendia et/ou configurer les pare-feux. Consultez votre service informatique 
pour obtenir de l’aide. 
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Configuration initiale 
 

CRÉAT ION D ’UN COMPTE  AD APT-CE  
 

1. Un e-mail d’inscription automatique est envoyé par Illumina ICA avec un lien 
vers le portail d’enregistrement ADAPT-CE. 

2. Ouvrez le lien contenu dans l’e-mail pour accéder au portail d’enregistrement 
ADAPT-CE. 

3. Entrez les informations demandées, 
a. « First Name » Prénom et « last Name» nom de famille associés à votre 

compte 
b. Pour respecter les exigences de sécurité, le mot de passe choisi doit inclure 

au moins l’un des caractères suivants : ! . @ # $ % ^ et * -  
4. Passez en revue les conditions générales et cochez la case pour accepter. 
5. Une fois que vous aurez cliqué sur « Register » (S’inscrire), ADAPT-CE aura 

enregistré les informations de votre compte. 
6. La page va maintenant être actualisée avec l’écran de connexion. Entrez vos 

identifiants pour accéder à votre compte nouvellement enregistré. 
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I NS T AL L AT I O N  D U  C O N NE C T E U R  D E  S E R V I CE  A G E N D I A  
Pour téléverser des données dans ADAPT-CE, vous devez télécharger et installer 
le connecteur de service Agendia afin de garantir un protocole de transfert de 
fichiers sécurisé et robuste. 

 ATTENTION : veuillez consulter votre service informatique avant d’installer 
un logiciel dans votre environnement professionnel. 
De plus, le connecteur ADAPT-CE nécessite que l’installation et le fonctionnement 
du programme se fassent sur un lecteur local. 
 
1. Connectez-vous à ADAPT-CE à l’adresse https://ica.illumina.com/ADAPT-CE. 

 Lors de la connexion sur certains navigateurs, les utilisateurs devront peut-
être cliquer deux fois sur « Sign In » (Connexion). 

2. Dans la barre de menu supérieure d’ADAPT-CE, cliquez sur « Settings » 
(Paramètres). 

3. Dans la section intitulée « Site Connectivity Settings » (Paramètres de 
connectivité du site), cliquez sur « New » (Nouveau). 

4. Entrez un nom unique pour votre connecteur. Par exemple, « Connecteur 
ADAPT-CE pour [Nom du site] ». 

5. Sélectionnez votre système d’exploitation dans la liste déroulante (Windows, 
Mac ou Linux). 
a. Si vous ne connaissez pas le système d’exploitation de votre ordinateur, 

demandez de l’aide à votre service informatique. 
6. Pour le « Local folder » (Dossier local), indiquez un chemin local pour le 

dossier contenant les fichiers FASTQ pertinents qui doivent être téléversés 
dans ADAPT-CE pour analyse. 
a. Exemple : « C:\ADAPT_Connector\FASTQ Uploads » 

7. Cliquez sur « Save » (Enregistrer) pour enregistrer les paramètres. 
8. ADAPT-CE affiche ensuite une clé d’initialisation essentielle à l’installation. 

Veuillez copier/coller cette clé dans un endroit sûr et récupérable, car vous 
en aurez besoin lors de la prochaine étape d’installation.  

9. ADAPT-CE ouvre alors une boîte de dialogue vous permettant d’enregistrer 
le programme d’installation du connecteur de service Agendia. 

10. Sélectionnez un emplacement dans le disque local de votre ordinateur et 
enregistrez le programme d’installation du connecteur de service Agendia. 
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11. Une fois le programme d’installation du connecteur de service téléchargé, 
accédez à l’emplacement du programme enregistré et lancez-le. 
a. Suivez les instructions du programme d’installation et cliquez sur « Next » 

(Suivant) lorsque vous y êtes invité(e). 
b. Sélectionnez le dossier d’installation du lecteur local. 
c. Entrez ou collez la clé d’initialisation fournie par ADAPT-CE à l’étape 8. 
d. L’installation va maintenant démarrer. 
e. Une fois l’installation terminée, cliquez sur « Finish » (Terminer) pour quitter 

le programme d’installation.  
f. Une fois l’installation réussie, le statut « currently connected » (actuellement 

connecté) apparaît dans « Site Connectivity Settings » (Paramètres de 
connectivité du site). 

g. Le connecteur de service Agendia est désormais prêt à être utilisé. 
 

PERSONNALISATION DES RAPPORTS ADAPT-CE 
[FACULTATIF]  
1. Connectez-vous à ADAPT-CE à l’adresse https://ica.illumina.com/ADAPT-CE. 
2. Cliquez sur « Settings » (Paramètres) dans la barre de menu supérieure et 

accédez à « Report Settings » (Paramètres du rapport).  
3. Pour ajouter un logo, cliquez sur « Report Logo » (Logo du rapport). 

a. Cliquez sur « Choose File » (Choisir un fichier) et accédez à l’emplacement 
du fichier du logo. Le format de fichier du logo doit être l’un des suivants : 
JPEG, GIF, BMP ou PNG et ne doit pas dépasser 5 mégaoctets (Mo). 

b. Une fois choisi, cliquez sur « Upload » (Télécharger). Un aperçu du logo 
s’affiche désormais. 
Remarque : le logo sera apposé dans le coin supérieur droit du « Technical 
Repor » (Rapport technique) et de l’« Explanation of Results » (Explication 
des résultats). 

4. Pour ajouter une signature, cliquez sur « Report Signature » (Signature du 
rapport). 
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c. Cliquez sur « Choose File » (Choisir un fichier) et accédez à 
l’emplacement de votre fichier de signature. Le format du fichier de 
signature doit être l’un des suivants : JPEG, GIF, BMP ou PNG et ne doit 
pas dépasser 5 mégaoctets (Mo). 

d. Une fois choisi, cliquez sur « Upload » (Télécharger). Un aperçu de la 
signature s’affiche désormais. 
Remarque : la signature apparaîtra dans la section inférieure gauche du 
« Technical Report » (Rapport technique) dans la case « Authorized 
Signature » (Signature autorisée). 

5. Pour réinitialiser les graphiques chargés, cliquez sur le bouton corbeille du 
logo/de la signature correspondant. 

6. Une case cochée « Export flat file » (Exporter un fichier plat) permet aux 
utilisateurs de télécharger des fichiers .json pour personnaliser davantage 
les rapports. 
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Utilisation d’ADAPT-CE 
TÉLÉVERSEMENT DE F ICHIERS FASTQ  

 
 ATTENTION : Pour garantir la confidentialité de vos patients, n’incluez aucune 

information personnelle identifiable (PII) dans les noms de vos fichiers FASTQ. 

 ATTENTION : Les noms de fichiers ne doivent contenir que des caractères 
alphanumériques (0-9, a-z, A-Z) et des caractères de soulignement (_). L’extension 
de fichier doit être au format « .fastq.gz » en minuscules. Par exemple, 
« ABC_123.fastq.gz »  

 ATTENTION : NE MODIFIEZ PAS le contenu de vos fichiers FASTQ. Cela 
peut entraîner la génération de résultats incorrects ou empêcher le traitement par 
ADAPT-CE. 

 
1. Lorsque vous êtes prêt(e) à téléverser, copiez le ou les fichiers FASTQ dans le 

dossier spécifié lors de l’étape 6 de « Installation du connecteur de service 
Agendia ». 
a. Si aucune extension de fichier n’apparaît dans votre navigateur de fichiers, 

contactez votre service informatique pour obtenir de l’aide. 
2. Le connecteur de service Agendia détectera la présence de nouveaux fichiers 

FASTQ et les téléversera automatiquement dans ADAPT-CE. 
3. Connectez-vous à ADAPT-CE à l’adresse https://ica.illumina.com/ADAPT-CE.  
4. Les téléversements en cours sont affichés dans la section « Active Uploads » 

(Téléchargements actifs) d’ADAPT-CE. 
5. Une fois le téléversement réussi, le fichier FASTQ apparaîtra sur le tableau de 

bord. 
6. Les fichiers FASTQ peuvent désormais être analysés pour générer des 

rapports. 
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ANALYSE DE DONNÉES 
1. Connectez-vous à ADAPT-CE à l’adresse https://ica.illumina.com/ADAPT-CE.  
2. Cliquez sur « Dashboard » (Tableau de bord) dans la barre de menu 

supérieure. 
3. Sélectionnez le ou les fichiers FASTQ que vous souhaitez analyser en cochant 

les cases correspondantes sur la même ligne que l’échantillon. 
4. Cliquez sur « Analyze » (Analyser). 
5. Vous serez invité(e) à saisir le « Pipeline » (Pipeline) et le « Activation code » 

(Code d’activation) pour configurer les paramètres d’analyse. 
 ATTENTION : Assurez-vous que les codes disponibles que vous 

sélectionnez contiennent suffisamment de réactions restantes pour l’analyse 
que vous avez planifiée. Si les réactions sont insuffisantes pour l’analyse prévue, 
vous devrez diviser votre lot afin de vous conformer aux codes de kit restants. 

6. Une fois que vous avez confirmé les entrées, cliquez sur « Analyze » (Analyser) 
pour démarrer l’analyse du (des) fichier(s) FASTQ. 

7. Lors de l’analyse des données, le champ d’état à côté du ou des fichiers FASTQ 
pertinents indiquera « processing » (traitement en cours). 

8. Une fois l’analyse des données terminée, le champ d’état à côté du ou des 
fichiers FASTQ pertinents indiquera « succeeded » (réussi). 

 
TÉLÉCHARGEMENT DE RAPPORTS 
 

1. Connectez-vous à ADAPT-CE à l’adresse https://ica.illumina.com/ADAPT-CE. 
2. Cliquez sur « Dashboard » (Tableau de bord) dans la barre de menu 

supérieure. 
3. Pour imprimer des rapports : 

a. Cochez la case à côté du ou des fichiers, puis cliquez sur « Print » 
(Imprimer). 

b. Votre logiciel de lecture de PDF ouvrira le ou les fichiers sélectionnés. 
c. Le rapport technique et les rapports d’explication des résultats peuvent 

désormais être imprimés. 
4. Pour enregistrer des rapports : 

a. Cochez la case à côté du ou des fichiers, puis cliquez sur « Save as PDF » 
(Enregistrer au format PDF). 

b. Votre logiciel de lecture de PDF ouvrira le ou les fichiers sélectionnés. 
c. Enregistrez les rapports dans le dossier de votre choix. 

Remarque : conformément aux politiques de conservation des données 
du système, les rapports PDF sont supprimés après un an, tandis que les 
fichiers FASTQ sont supprimés après 30 jours. 
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Rapports ADAPT-CE 
 

ADAPT-CE génère deux rapports, le « Rapport technique » et l’« Explication 
des résultats ». Dans ce guide de l’utilisateur, un exemple de cas présentant un 
résultat à risque faible selon MammaPrint et un résultat Luminal A BluePrint 
sera utilisé pour illustrer l’utilité du rapport technique et de l’explication des 
résultats. Les deux rapports sont combinés dans un seul PDF. 
A. RAPPORT TECHNIQUE (TR) 

Le TR est fourni en tant qu’outil permettant d’obtenir une vue d’ensemble 
de haut niveau des résultats du test, des informations relatives à l’exécution 
et des informations relatives au contrôle qualité. 

B. EXPLICATION DES RÉSULTATS (EOR) 
L’EoR est fournie en tant qu’outil pour compléter les résultats fournis dans 
le TR décrit ci-dessus. L’explication des résultats explique les résultats de 
MammaPrint et de BluePrint dans le contexte des données cliniques 
publiées. 

 

Rapport technique 
 

Le rapport technique contient les sections suivantes : 
1. ID du fichier d’échantillon 
2. RÉSULTATS DU TEST 

a. MammaPrint 
b. BluePrint 

3. INFORMATIONS SUR L’EXÉCUTION  
4. INFORMATIONS DÉTAILLÉES SUR LE CONTRÔLE 

QUALITÉ 
 

1. ID du f ichier d’échanti l lon  
 ATTENTION : Les utilisateurs sont tenus de s’assurer que tous les fichiers 

téléversés sont anonymisés. L’ID du fichier d’échantillon est le nom du fichier 
FASTQ qui a été analysé pour générer le rapport technique. Pour garantir la 
confidentialité de vos patients, N’incluez AUCUNE information personnelle 
identifiable (PII) dans le nom de votre fichier FASTQ. ADAPT-CE ne fera 
correspondre l’ID du fichier d’échantillon à aucune autre information.  
  9 
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2. RÉSULTATS DU TEST 
a. RÉSULTAT DU TESTMAMMAPRINT 

Le résultat de MammaPrint est fourni sous forme de résultat binaire 
« Low Risk » (Risque faible) ou « High Risk » (Risque élevé) pour le 
risque de récidive. Le profil de prognostique (risque faible, risque 
élevé) de l’échantillon est déterminé en calculant l’indice MammaPrint 
(MPI) sur une échelle de -1,000 à +1,000. 
• Les résultats à risque élevé sont ceux qui sont égaux ou inférieurs 

à 0,000. 
• Les résultats à faible risque sont ceux supérieurs à 0,000. 
Si l’indice MammaPrint (MPI) se situe dans une zone prédéfinie autour 
du seuil de classification compris entre -0,058 et +0,058, la fiabilité de 
la classification est inférieure à 90 %. 
Remarque : EoR donnera plus de détails sur les différents groupes 
de risque MammaPrint. 

 
b. RÉSULTAT DU TEST BLUEPRINT 

Le résultat de BluePrint est fourni sous forme de type Luminal, de 
type HER2 ou de type Basal. Le sous-type ayant la valeur la plus élevée 
est le sous-type dominant et est donc le résultat de BluePrint. Dans 
le cas de sous-types ayant la même valeur d’index, le résultat 
affichera : « Mixed-subtype » (Sous-type mixte). 
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3. INFORMATIONS SUR L’EXÉCUTION 
Cette section contient des informations sur l’analyse réalisée par ADAPT-CE. 
Le tableau ci-dessous fournit des informations supplémentaires : 

 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4. INFORMATIONS DÉTAILLÉES SUR LE CONTRÔLE 
QUALITÉ 
• Cette section contient diverses mesures de contrôle qualité (CQ) 

dans les résultats d’analyse d’un échantillon individuel. Le nombre total 
de lectures, le pourcentage cartographié, le pourcentage atteignant la 
cible et le pourcentage Q30 sont couramment utilisés pour l’analyse 
des données de séquençage de l’ARN.  

• La métrique de qualité de l’ARN est utilisée pour donner un aperçu 
de la qualité globale de l’ARN isolé. 

• Les autres métriques de contrôle qualité sont la propriété d’Agendia 
et font partie de l’algorithme d’ADAPT-CE. 

Informations sur 
l’exécution 

Détails 

Échantillons en cours Le nombre d’échantillons dans un cycle 
d’analyse 

Numéro de série de l’instrument Le numéro de série de l’instrument MiSeq 

Date de soumission des 
données 

Date à laquelle les fichiers FASTQ sont 
détectés et téléversés 

Date de génération du rapport Date à laquelle les rapports sont analysés 

Version de l’ensemble humain La version du génome humain utilisée pour 
cartographier les lectures de NGS. 

Version du logiciel La version du composant d’analyse 
d’ADAPT-CE 

Version du modèle de CQ La version du modèle QC 
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4. INFORMATIONS DÉTAILLÉES SUR LE 
CONTRÔLE QUALITÉ (suite) 
Si l’une des métriques de contrôle qualité susmentionnées, ou une 
combinaison de métriques de contrôle qualité, échoue, 
• La section Résultats du test affichera : 

o MammaPrint : aucun résultat 
o BluePrint : aucun résultat 

• Les informations d’exécution sont statiques. 
• L’évaluation globale des informations détaillées sur le contrôle qualité 

affichera un verdict « Fail » (Échec). 
• Aucune explication ultérieure des résultats ne sera fournie. 
 
Remarque : si un logo personnalisé a été téléversé dans 
« CUSTOMIZING ADAPT-CE REPORTS » (PERSONNALISATION DES 
RAPPORTS ADAPT-CE), il apparaîtra dans la case verte. 
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 Explication des résultats (EoR) 
 
Le document EoR de trois pages peut contenir les sections clés suivantes : 
Page de résumé d’EoR (p. 1 sur 3) 
1. ID du fichier d’échantillon 
2. Résultats des tests génomiques  
3. Conséquences cliniques 

a. Planification de la chimiothérapie néoadjuvante 
b. Planification de la chimiothérapie adjuvante 
c. Planification de la thérapie endocrinienne adjuvante 

 
Données sur la chimiothérapie de l’EoR (p. 2 sur 3) 
4. Données sur la planification de la chimiothérapie néoadjuvante 
5. Données sur la planification de la chimiothérapie adjuvante 
 
Données sur le système endocrinien de l’EoR/Références (p. 3 sur 3) 
6. Données sur la planification de la thérapie endocrinienne (ET) adjuvante 
7. Références des études cliniques et des essais 

 
Remarque :  
- Les 3 pages de l’EoR sont dynamiques sur la base des résultats de 

MammaPrint et BluePrint. 
- Si vous avez téléversé un logo personnalisé dans la section 

« CUSTOMIZING ADAPT-CE REPORTS » (PERSONNALISATION 
DES RAPPORTS ADAPT-CE), celui-ci remplacera le logo Agendia dans 
le coin supérieur droit des 3 pages de l’EoR. 
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Page de résumé d’EoR (1 sur 3) 
 

1. ID  du f ich ier  d’échant i l lon  
 ATTENTION : Les utilisateurs sont tenus de s’assurer que tous les 

fichiers téléversés sont anonymisés. L’ID du fichier d’échantillon est le nom 
du fichier FASTQ qui a été analysé pour générer le rapport technique. Pour 
garantir la confidentialité de vos patients, N’incluez AUCUNE information 
personnelle identifiable (PII) dans le nom de votre fichier FASTQ. ADAPT-
CE ne fera correspondre l’ID du fichier d’échantillon à aucune autre 
information.  
 

2. RÉSULTATS DES TESTS GÉNOMIQUES 
Cette section développe les résultats de MammaPrint et de BluePrint tirés 
du rapport technique : 
a. Groupe de risque MammaPrint : 

Risque élevé I, risque élevé 2, risque faible et risque très faible 
b. Indice MammaPrint (4 chiffres) : +/- 1,000 
c. Sous-type moléculaire BluePrint. 

Luminal A, Luminal B, HER2, basal ou mixte 
d. Diagramme de l’indice MammaPrint par rapport au groupe de risque 

relatif 
 

3. CONSÉQUENCES CLINIQUES 
Cette section présente des informations cliniques dynamiques dérivées du 
groupe de risque MammaPrint et du sous-type BluePrint, sur la base de 
plusieurs études cliniques (voir l’explication des résultats à la page 3). 
e. PLANIFICATION DE LA CHIMIOTHÉRAPIE NÉOADJUVANTE 
La réponse pathologique complète (RPC ) est déterminée par le sous-type 
BluePrint, sauf si le sous-type est mixte, auquel cas elle est basée sur la RPC 
moyenne observée dans le groupe de risque MammaPrint. 
f. PLANIFICATION DE LA CHIMIOTHÉRAPIE ADJUVANTE 

Dynamique et basée sur le groupe de risque MammaPrint 
g. PLANIFICATION DE LA THÉRAPIE ENDOCRINIENNE 

Dynamique et basée sur le groupe de risque MammaPrint 
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Données sur la chimiothérapie de 
l’EoR (p. 2 sur 3) 
 

4. DONNÉES SUR LA PLANIFICATION DE LA 
CHIMIOTHÉRAPIE  NÉOADJUVANTE  
a.  Probabilité de RPC basée sur le sous-type BluePrint et le groupe de 

risque MP Voir NBRST/FLEXA, B à la page 3 d’EoR pour plus de détails. 
Le résultat respectif sera mis en évidence avec la probabilité de RPC. 
• Luminal A à faible risque : 2 % 
• Luminal B à risque élevé 1 : 6 % 
• Luminal B à risque élevé 2 : 22 % 
• Type basal : > 34 % 
• Type HER2 : > 54 % 
• Sous-type mixte : pas de mise en évidence 

 
b.  Probabilité de RPC basée sur l’indice MammaPrint et le groupe de risque 

MammaPrint. Voir NBRSTA à la page 3 d’EoR pour plus de détails. 
 

 
5. DONNÉES SUR LA PLANIFICATION DE LA 

CHIMIOTHÉRAPIE  ADJUVANTE  
Dynamique et basée sur le groupe de risque MammaPrint 

• Risque très faible illustrera les résultats sur 8 ans  
• Tous les autres groupes de risque présentent des résultats sur 5 ans 
• Selon les résultats, voir la page 3 pour les études respectives. 

Risque très faible et risque faible — voir MINDACT D 
Risque élevé 1 et risque élevé 2 — Voir FLEX/Knauer B/F 
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Données sur le système endocrinien de 
l’EoR / Références (p. 3 sur 3) 
 

6. Données  sur  la  plani f icat ion  de la  thérapie endocrin ienne 
(ET)  adjuvante 
Dynamique et basée sur le groupe de risque MammaPrint 

• Très faible est doté d’un STO-3C supplémentaire 
• Les groupes de risque seront encadrés par NSABP B-42 E 

7. Références des études cl in iques et  des essais  
A. NBRST 
B. FLEXIBLE (NCT03053193) 
C. STO-3 
D. MINDACT 
E. NSABP B-42 
F. Knauer (ajouté pour Risque élevé 1 ou Risque élevé 2) 
 
Références : 
1. Whitworth P et al. Ann Surg Oncol. 2017 Mar;24(3):669-675. 
2. Whitworth P et al. JCO Precis Oncol. 2022 Apr;6(1):e2100463. 
3. Whitworth P et al. AnnSurg Oncol. 2022 Apr 4;29(7):4141-4152. 
4. Whitworth P et al. JCO Precis Oncol. 2022 Sep:6:e2200197. 
5. O’Shaughnessy J et al. 2021. ASCO. Abstract#563. 
6. O’Shaughnessy J et al. 2023. SABCS. Abstract PO5-15-04. 
7. Audeh MW et al. 2024. MBCC. Poster #29. 
8. van ‘t Veer L et al. Breast Cancer ResTreat. 2017;166(2):593-601. 
9. Esserman LJ et al. JAMA Oncol. 2017;3(11):1503-1510. 
10. Piccart M et al. Lancet Oncol. 2021;22(4):476-488. 
11. Lopes-Cardozo J et al. J Clin Oncol. 2022;40(12):1335-1345. 
12. Rastogi P et al. J Clin Oncol. 2024;00:1-9. 
 
Remarque : Les deux références suivantes sont insérées pour le risque 
élevé 1/II  

• Brufsky A et al. 2024. SACS. P2-08-12 
• Knauer M et al. Breast Cancer Res Treat. 2010;120(3):655-61. 
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Résolution des problèmes 
 

• Les points de dépannage suivants concernent des sujets liés à la configuration et au fonctionnement d’ADAPT-CE. 

• Pour obtenir une liste supplémentaire de sujets de dépannage, reportez-vous à l’onglet (Aide) en haut à droite de l’interface ADAPT-CE. 
 

 
Problème Solution 

Vous avez oublié votre mot de passe pour ADAPT-CE. Accédez à l’écran de connexion à l’adresse https://ica.illumina.com/ADAPT-CE. Cliquez sur le lien « Forgot 
password? » (Mot de passe oublié) et suivez les instructions fournies. Si vous ne parvenez toujours pas à vous 
connecter, contactez NGS.support@agendia.com pour obtenir de l’aide supplémentaire. 

Vous rencontrez des problèmes lors de la configuration du 
connecteur de service Agendia. 

Accédez à la section « Settings » (Paramètres) d’ADAPT-CE et cliquez sur « Delete » (Supprimer) sur le connecteur 
avec lequel vous rencontrez des problèmes. Assurez-vous qu’un dossier local est créé sur l’ordinateur et suivez les 
étapes pour installer un autre connecteur portant un nom unique. 

Les fichiers ne sont pas téléversés dans ADAPT-CE via le 
connecteur de service Agendia. 

Accédez à la section « Settings » (Paramètres) d’ADAPT-CE et assurez-vous que le « Local folder » (Dossier local) 
répertorié pour le connecteur de service Agendia correspond au dossier dans lequel se trouvent les fichiers FASTQ. 

Les pages d’ADAPT-CE ne fonctionnent pas comme prévu. Cliquez sur le bouton « Refresh » (Actualiser)  sur la page. Si le problème persiste, contactez 
NGS.support@agendia.com. 

Des fichiers FASTQ dupliqués apparaissent dans ADAPT-CE. Assurez-vous que les fichiers FASTQ ne sont téléversés qu’une seule fois lorsque vous utilisez le connecteur de 
service Agendia. Si des doublons sont chargés, accédez au dossier de téléversement du connecteur de service 
Agendia, supprimez les doublons et téléversez à nouveau un seul fichier. 

Le résultat d’un échantillon inclut uniquement un rapport 
technique et n’inclut pas de document d’explication des résultats 
(EoR). 

Consultez le verdict pour l’évaluation globale. S’il indique « Fail » (Échec), aucune explication des résultats (EoR) n’est 
générée pour l’échantillon. 

Les rapports d’échantillon ne peuvent pas être enregistrés ou 
imprimés.  

Assurez-vous que le champ d’état à côté de l’échantillon sur la page « Dashboard » (Tableau de bord) indique 
« succeeded » (réussi) et qu’une icône PDF  est affichée. 

Les fichiers FASTQ restent en cours dans la rubrique « Active 
Uploads » (Téléversements en cours) après avoir supprimé le 
fichier FASTQ du connecteur ou après le téléversement réussi du 
fichier FASTQ dans le tableau de bord. 

Cliquez sur le bouton « Abort Data Transfer Functionality » (Stopper la fonctionnalité de transfert de données)  
dans « Active Uploads » (Téléversements actifs) pour le fichier FASTQ en cours que vous souhaitez supprimer. 
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Divers  
 

SÉCURITÉ 
Agendia a établi une politique de confidentialité et des conditions d’utilisation 
disponibles sur notre site Web à l’adresse www.agendia.com pour vous 
informer des pratiques et des directives spécifiques qui contribuent à garantir 
la sécurité et la confidentialité des informations personnelles que vous pouvez 
fournir.  
 
En utilisant ou en accédant au Site, y compris au connecteur de service 
Agendia, ou en transmettant des informations via le connecteur de service 
Agendia, vous acceptez les conditions de notre Politique de confidentialité et 
nos Conditions d’utilisation. Si vous n’êtes pas d’accord avec les conditions de 
la Politique de confidentialité et les Conditions d’utilisation ou de futures 
conditions, n’accédez pas au Site, ne l’utilisez pas (ou ne continuez pas à y 
accéder) et ne transmettez pas d’informations via le connecteur de service 
Agendia. Votre utilisation continue du Site et du Connecteur de service 
Agendia, même après la publication de mises à jour de notre Politique de 
confidentialité et de nos Conditions d’utilisation, constitue votre acceptation 
de cette utilisation.  
 

DÉLAI  D ’EXPIRAT ION DE  LA SESS ION D U NAVIGATEUR ET 
SYMBOLES  
Pour des raisons de sécurité, après 15 minutes d’inactivité dans le navigateur, 
le logiciel met automatiquement fin à votre session et vous déconnecte. Un 
message d’avertissement s’affichera avant de vous déconnecter, vous donnant 
la possibilité de rester connecté(e). 

 
Si vous avez des questions concernant ce produit, veuillez contacter 
NGS.Support@agendia.com ou par téléphone au +31 (0) 20 462 1510, du 
lundi au vendredi de 8h30 à 17h00 (GMT/UTC +1). 
 

 
Numéro de version et date de publication 
EM-002-v6-FR, mars 2025 

 
 
 

Symbole Nom du symbole Description du symbole 

 
 
  

Fabricant Indique le fabricant du dispositif médical, tel 
que défini dans les directives européennes 
90/385/CEE, 93/42/CEE et 98/79/CE. 

 Attention 

 
Indique la nécessité pour l’utilisateur de 
consulter le mode d’emploi pour obtenir 
des informations de mise en garde 
importantes telles que des mises en garde 
et des précautions qui ne peuvent pas, pour 
diverses raisons, être présentées sur le 
dispositif médical lui-même. 

 Dispositif médical de 
diagnostic in vitro 

Indique un dispositif médical destiné à être 
utilisé comme dispositif médical de 
diagnostic in vitro. 
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Agendia®, MammaPrint® et BluePrint® sont des marques commerciales 
d’Agendia NV et/ou de sa filiale aux États-Unis. Tous les autres noms et autres 
marques commerciales appartiennent à leurs propriétaires respectifs. Les 
instructions de ce document doivent être strictement suivies par un 
personnel qualifié et correctement formé afin de garantir une utilisation 
correcte et sûre du produit décrit ici. 
LE FAIT DE NE PAS LIRE COMPLÈTEMENT ET DE NE PAS SUIVRE 
EXPLICITEMENT TOUTES LES INSTRUCTIONS CONTENUES DANS CE 
DOCUMENT PEUT ENDOMMAGER LE PRODUIT ET BLESSER DES 
PERSONNES, Y COMPRIS LES UTILISATEURS OU D’AUTRES PERSONNES. 
AGENDIA N’ASSUME AUCUNE RESPONSABILITÉ RÉSULTANT D’UNE 
MAUVAISE UTILISATION DU OU DES PRODUITS DÉCRITS ICI (Y COMPRIS 
DES PARTIES DE CEUX-CI OU DES LOGICIELS). 
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